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Prior to Using This Document: Videology reserves the right to modify the information in this 

document as necessary and without notice. It is the user’s responsibility to be certain they possess the 

most recent version of this document by going to www.videologyinc.com, searching for the model 

number, and comparing revision letters on the respective document, located in the document’s footer. 

 
For technical assistance with this product, please contact the supplier from whom the product was 
purchased.  
 

 

Videology® Imaging Solutions, Inc. Videology® Imaging Solutions, Europe B.V. 

 

37M Lark Industrial Parkway 
Greenville, Rhode Island 02828 USA 
Tel: (401) 949 – 5332  Fax: (401) 949 – 5276 
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5405 NH Uden, The Netherlands 

Tel: +31 (0) 413 256261 Fax: +31 (0) 413 251712 
 Europe & N. Eurasia sales: 

  info@videology.nl 

USB Photo ID Cameras 
 

Instruction Manual for Videology Viewers 
SFT-07019 and SFT-07019-WHQL 

TWAIN Data Source SFT-10011 

IMAGING SOLUTIONS INC. 
Original Equipment Manufacturer 

20K758USB-SYS-1 24C7.3XUSB-F-L8 

24C7.3XUSB 

20K758USB-C-1 

20/21C11XUSB 
20/21C21XWUSB 

60C002USB.C 
60C002USB.C-3.3 

24B1.3XUSB-C 
24C1.3XUSB 

20/21K35XUSB 
20/21K45XUSB 

20/21B14XUSB 

20/21K13XUSB-C 
20/21K14XUSB-C 
20/21K15XUSB-C 

http://www.videologyinc.com/
mailto:sales@videologyinc.com
mailto:info@videology.nl


Doc # INS-07019 Issue Date: 06/03/2016 

Revision: F Page 2 of 53 

 

License Agreement (Software): 

This Agreement states the terms and conditions upon which Videology Imaging Solutions, Inc. USA and 

Videology Imaging Solutions, B.V. Europe (hereafter referred to as "Videology®") offer to license to you 

the software together with all related documentation and accompanying items including, but not limited 

to, the executable programs, drivers, libraries, and data files associated with such software. 

The Software is licensed, not sold, to you for use only under the terms of this Agreement. 

Videology grants to you, the purchaser, the right to use all or a portion of this Software provided that the 

Software is used only in conjunction with Videology's family of products. 

In using the Software you agree not to: 

 Decompile, disassemble, reverse engineer, or otherwise attempt to derive the source code for any 

Product (except to the extent applicable laws specifically prohibit such restriction); 

 Remove or obscure any trademark or copyright notices. 

 

Limited Warranty (Hardware and Software): 

ANY USE OF THE SOFTWARE OR HARDWARE IS AT YOUR OWN RISK. THE SOFTWARE IS PROVIDED FOR 

USE ONLY WITH VIDEOLOGY'S HARDWARE. THE SOFTWARE IS PROVIDED FOR USE "AS IS" WITHOUT 

WARRANTY OF ANY KIND, TO THE MAXIMUM EXTENT PERMITTED BY LAW, VIDEOLOGY DISCLAIMS ALL 

WARRANTIES OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, IMPLIED 

WARRANTIES OR CONDITIONS OF MERCHANTABILITY, QUALITY AND FITNESS FOR A PARTICULAR 

APPLICATION OR PURPOSE. VIDEOLOGY IS NOT OBLIGATED TO PROVIDE ANY UPDATES OR UPGRADES 

TO THE SOFTWARE OR ANY RELATED HARDWARE. 

 

Limited Liability (Hardware and Software): 

In no event shall Videology or its Licensors be liable for any damages whatsoever (including, without 

limitation, incidental, direct, indirect, special or consequential damages, damages for loss of business 

profits, business interruption, loss of business information, or other pecuniary loss) arising out of the use 

or inability to use this Software or related Hardware, including, but not limited to, any of Videology's 

family of products. 
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1. Document History 

2. Overview 

2.1. The Videology USB Camera Family 

Videology USB Cameras provide a quick and easy means of displaying and capturing high quality video 

and images on any USB 2.0 equipped desktop or laptop computer running a supported Microsoft® OS. 

 

Designed with flexibility in mind, each camera model has its own distinct advantage, whether speed, 

resolution, image quality, sensitivity or price. Because they are USB based, there is no need for a frame 

grabber. Instead, a single USB cable provides power, video frames, control and data transfer. 

 

 All cameras share the same simple, powerful API allowing easy migration from one camera to 

another.  

 SDKs are available for OEMs (for an additional fee). 

 Housings: Mechanical design options can be quoted for OEMs 

This fixed lens camera family can utilize any CS mount lens. The lens may be changed out for a more 

optimal focal length. Varifocal lenses allow a wider range of focal lengths within one lens.  

 

Note: Use a Megapixel lens with the Megapixel 24C7.38USB camera in order to maintain the full 

resolution. 

2.2. Contents 

This camera package has two software executables. 

1. SFT-07019 (Videology Viewer software and USB drivers)  

or SFT-07019-WHQL (WDM device drivers are Microsoft® digitally certified) 

2. SFT-10011 (TWAIN data source) 

 

To check for updated software, please go to www.videologyinc.com/download.htm 

 

The Videology viewer (SFT-07019-WHQL) can operate this camera family without a need for any third 

party software. It will auto recognize which camera is plugged in and show the corresponding controls and 

features for that camera.  

 

Note: All cameras stream video and have a still capture mode. 

 

Many users wish to utilize a Photo ID card software management platform. In this case a separate TWAIN 

driver is needed (SFT-10011). ALL third party software packages allow a camera to be recognized thru 

their TWAIN (or Scanner) drop down camera source choices. This TWAIN interface is recommended as the 

primary method to integrate with the Videology camera. 

 

If the software photo ID management program has a standards based DirectShow compliant interface, the 

camera will work with that interface. However, we have found many third party software platforms do not 

conform to DirectShow on all operating systems. 

Rev Date Reason CN# 

Rev F 09-14-15 -C models have been updated, now C-1 16-0058 

Rev E 06-08-15 Updated flash section 8.3.9  15-0065 

Rev D 04-16-14 20/21C11XWUSB, 20/21C21XWUSB cameras added 14-0082 

Rev C 08-31-12 Section 8.2 updated, added V pulse and frame rate  

(24B1.3XUSB-V) 

12-0138 

Rev B 03-15-12 Added camera 24C7.38USB-F, flash camera instructions section 8.3.9 12-0038 

Rev A 07-22-11 Manual updated for all camera models. 

For software SFT-07019 rev 1.0.110, SFT-07019-WHQL rev 1.0.105. 

Added TWAIN Instructions - SFT 10011 rev 2.1.11 

11-0075 

http://www.videologyinc.com/download.htm
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3. Camera Features 

20/21B14XUSB 
USB 2.0 1/4" CMOS Color Board Camera 

 22mm x 26mm mini-board is compatible with previous 20/21K14XUSB-C family products 

 All-digital design uses camera board's digital (D1) output for input to USB board 

 USB 2.0 bus provides power to camera 

 

20/21C11XWUSB 
1/3" CMOS Color Board Camera with USB 2.0 

 1/3" CMOS sensor (690TVL) 

 Miniature rugged 22mm x 26mm double board 

 Low 0.1 lux sensitivity 

 Metal CS, M-12 and pinhole lens mounts 

 Optional mini metal housings suitable for ATMs and Kiosks 

 

20/21C21XWUSB 
1/3" CMOS WDR Color Board Camera with USB 2.0 and CVBS Video Output 

 Provides analog (CBVS) and USB (2.0) video output simultaneously 

 1/3" CMOS sensor (690TVL) 

 Dynamic range to 120dB provides brilliant color detail within both shadows and 

brightest light scenes 

 Miniature rugged 22mm x 26mm double board 

 Low 0.1 lux sensitivity 

 Metal CS, M-12 and pinhole lens mounts 

 Optional mini metal housings suitable for ATMs and Kiosks 

 

20/21K35XUSB 
1/4" CCD High Resolution B&W Board Camera with USB 2.0 Video Output 

 22mm x 26mm mini-board is compatible with previous 20/21K13XUSB-C family products 

 USB 2.0 bus provides power to camera 

 I²C control 

 Lens mounts: metal CS, M12 board or pinhole 

 

20/21K45XUSB 
1/4" CCD High Resolution Color Board Camera with USB 2.0 Video Output 

 22mm x 26mm mini-board is compatible with previous 20/21K15XUSB-C family products 

 USB 2.0 bus provides power to camera 

 I²C control 

 Lens mounts: metal CS, M12 board or pinhole 

 

20/21K758USB-C-1 
USB 2.0, High Resolution Color Box Camera 

 CCD sensor provides high sensitivity & image quality 

 Still image capture with streaming video 

 USB 2.0 bus provides power and camera control 

 

20/21K758USB-SYS-1 
USB, High Resolution Color Camera for Photo Identity Systems 

 CCD sensor provides high sensitivity and quality 

 Still image capture with streaming video 

 Flexible gooseneck arm allows for easy camera control 

 Small footprint saves table space 

 USB 2.0 bus provides power and camera control 
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24B1.3XUSB-C 
High Definition 1.3 Megapixel B&W Single Board Camera with USB Video Output 

 Progressive scan, 1.3 megapixel CMOS sensor (square pixels) 

 Sensor is optically centered within lens mount holes 

 Streaming video or single frame capture via hardware/software 

 Triggerable instantaneous snap shots (model 24B1.3XUSB-V) 

 24fps at full 1280 x 1024 resolution uncompressed video 

 Simplified cabling - video, power and full camera control over a single USB cable 

 Extended integration time (>0.5 sec.) 

 

24C1.3XUSB 
CMOS USB 2.0 1.3 Megapixel Sensor Color Board Camera 

 Progressive scan, 1.3 megapixel CMOS sensor 

 >12.5fps at 720p high definition uncompressed resolution 

 USB 2.0 bus provides power and camera control 

 

24C7.38USB  
USB, Megapixel Color Box Camera 

 1.3 megapixel progressive scan sensor 

 >12.5fps at 720p high definition uncompressed resolution 

 Still image capture with streaming video 

 USB 2.0 bus provides power and camera control 

 

24C7.38USB-F-L8 
USB Megapixel Color Box Camera with Flash 

 Synchronized USB powered LED flash for consistent high quality images in any environment 

 1.3 megapixel progressive scan sensor 

 >12.5fps at 720p high definition uncompressed resolution 

 Still image capture with streaming video 

 USB 2.0 bus provides power, camera and flash control 

 Convenient manual dial allows customized flash intensity 

 

60V002USB-C 
USB Digitizer Board (5VDC Power Supply) 

 Video Inputs (multiplexed): 

- 1x composite video, 1x S-video 

- Video formats: NTSC/EIA, PAL/CCIR  

 Video Output: 

- USB 2.0, uncompressed image data streams 

- Max resolution (NTSC/ EIA): 704 x 480 at 30Hz 

- Max resolution (PAL/CCIR): 768 x 576 at 25Hz  

 Power input USB 2.0, 5VDC 

 Power throughput 5VDC up to 200mA for powering camera boards such as 20B14XDIG series 

 

60V002USB-C-3V3 
USB Digitizer Board (3.3VDC Power Supply)  

 Video Inputs (multiplexed): 

- 1x composite video, 1x S-video 

- Video formats: NTSC/EIA, PAL/CCIR  

 Video Output: 

- USB 2.0, uncompressed image data streams 

- Max resolution (NTSC/ EIA): 704 x 480 at 30Hz 

- Max resolution (PAL/ CCIR): 768 x 576 at 25Hz  

 Power input USB 2.0, 5VDC 

 Power throughput 3.3VDC up to 200mA for powering camera boards such as 20B45 series 
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4. Mounting Methods 

The cameras (20K758USB-C-1 and 24C7.38USB) are fitted with a ¼-twenty screw thread so that any 

common tripod can be used.  

                                       
 

 

 

 

 

The 20K758USB-SYS-1 has a unique stand 

that integrates the camera with a stand that 

can withstand a 40 degree tilt and still stabilize 

upright. The camera cannot dissemble from 

the stand, as it is totally integrated with 

cabling that threads within the assembly. 

 

The cable neatly emerges from the base of the 

stand (eliminating the potential to entwine 

around a tripod’s legs or to pull the camera 

down if accidentally twisted). 

 

Tabs are provided to attach the base of the 

stand to a table, thereby fully immobilizing the 

stand. 

 

 

20K758USB-SYS-1 
Exploded Assembly 

¼-twenty mount 
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5. Minimum System Requirements  

A PC with USB 2.0 compatible port. 

 

MAC is not supported. 

USB 1.1 is not supported. 

 

Preview only  

 PIII- 1.1GHz or above  

 128MB of RAM (256MB preferred)  

 Windows XP/2000 for USB2.0 

 DirectX/DirectShow 9.0c or later  

 Windows XP Service Pack 1 (Service Pack 2 Preferred) Windows 2000 Service Pack 4  

 

Preview and capture at the same time  

 Full D1 MPEG 2 - P4 – 2.4GHz or above  

 640 x 480 MPEG 2 - P4 – 2.0GHz or above  

 352 x 288 MPEG1 - P4 – 1.5GHz or above  

 Hard Disk - 5400RPM or above (7200RPM preferred)  

 128MB of RAM (256MB preferred)  

 Windows XP/2000 for USB2.0  

 DirectX/DirectShow 9.0c or later  

 Windows XP Service Pack 1 (Service Pack 2 Preferred) Windows 2000 Service Pack 4  

 

 

Verify system has the latest USB 2.0 host driver from Microsoft® only.  

 

Verify that USB host controller chipset is Microsoft certified.  

 

This product is not guaranteed to operate with a USB 2.0 host driver or application from OWC 

(Other World Computing). 
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6. Viewer and USB Driver Installation 

 Note: SFT-07019-WHQL WDM device drivers are Microsoft® digitally certified 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6.1. Viewer Installation (All Models) 

Insert the CD labeled USB Viewer Software (SFT-07019 or SFT-07019-WHQL). Click the executable file 

named SetupVid.exe.  

 

Videology's viewer software automatically checks which operating system is running and loads the 

appropriate drivers (32bit or 64bit). 

 

The following screen will appear: 

 

 
 

If you wish to install the viewer in a location other than the default directories, click on the Browse button 

and specify the desired location, otherwise click on the Install Button and the following screens will 

appear: 

 

Note: If you have a previous version of the Videology USB camera software installed 

on your computer, you should first remove this. To remove an older version, go to Start 

and select all programs, Find the Videology Cameras folder and select the Uninstall 

Viewer option. 

Please install the software first. 
Do not connect the camera to the computer before installing the 

software. 
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Click Next to continue. 
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Next, the Windows Security window opens informing that the WDM device drivers are Microsoft® digitally 

certified. Depending on the software version one of these windows will open: 

 

 
SFT-07019-WHQL 

 

 

 
SFT-07019 
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Click Install or Continue Anyway. 

 

 
 

 
 

The driver and viewer installation is now complete. Click Finish. 

 



Doc # INS-07019 Issue Date: 06/03/2016 

Revision: F Page 13 of 53 

 

 
 

Click Close to exit the hardware wizard.  

 

 

You can now connect the Videology camera to your PC using any available USB port. When the camera is 

connected, your computer will report that a new USB device has been detected, and will proceed to install 

the driver. Each time the camera is connected to a different USB port, the driver will be installed, this will 

be done only once for each port. 

 

Please refer to section 8 for launching the Videology viewer. 

 

Note: 

24C7.38USB-F Ensure that the cable connecting the camera to the flash module is connected at both 

ends, push the plugs in firmly to ensure a good connection. 

 

The camera is now ready for use. 
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7. TWAIN Installation 

To install the TWAIN data source, insert the CD labeled Twain Data Source and double click the 

executable file named SFT-10011 - TDS -Rev 2-1-18.exe. 

 

Note: the file name might be slightly different depending on the revision level of the software. 

 

The following window will appear: 

 

 
 

If the viewer is to be installed in a location other than the default directories, click on the Browse button 

and specify the desired location, otherwise click on the Install Button and the following screens will 

appear: 

 

 

 

 

The TWAIN driver installation is now complete. Click Close to exit the hardware wizard.  
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8. Using the Videology Viewer 

After software installation, plug in the USB cable from the camera. A window will pop up stating that 

Windows is installing the device drivers: 

 

 
 

Upon completion a second window will state the driver software installed successfully: 

 

 
 

NOTE: There is no auto focus feature in these cameras.  Once camera is focused, the user can 

modify the settings. 

 

For 20K1XXUSB-C-1 series (USB board and box cameras) 

see section 8.1 

 

For 24B1.3XUSB-C (monochrome 1.3 megapixel) 

see section 8.2 

 

For 24C1.3XUSB-C, 24C7.38USB-F (color 1.3 megapixel)  

see section 8.3 

 

For 2XC21XW-USB 

see section 8.4 

 

For 24C7.38USB-F, ensure that the cable connecting the camera to the flash module is connected at both 

ends; push the plugs in firmly to ensure a good connection. 

 

The camera is now ready for use. 

 

 

NOTE: 60V002USB-C  

USB Digitizer Board will incorporate whichever viewer software is supplied with the camera. Please refer to 

the corresponding sections for that particular camera. 
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8.1. Using the Videology viewer with models 2XK1XXUSB-C-1  

Please refer to section 6 Viewer and USB Driver Installation for viewer installation instructions. 

 

To launch the viewer software, simply click on the Videology Icon on the Desktop. A window will appear 

displaying the camera image. 

 

 
 

8.1.1. Using the Control Panel 

Clicking on the Control option on the menu bar will display the control panel. The control panel can be 

used to make changes to the camera settings. The various control features are discussed in more detail in 

the following pages. 
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8.1.2. Shutter Mode 

For this type of camera, the shutter speed refers to an electronic shutter, which determines the length of 

time over which charge is accumulated on the image sensor. There is no physical shutter.  

 

In low-light conditions, a slow shutter speed (long integration time) is required in order to get a quality 

image. However, if there is significant motion in the scene, a slow shutter speed will result in significant 

blurring of the image, and a faster shutter speed will be needed to get a clear sharp image. 

 

The shutter speed of Videology USB cameras can be varied from 1/50 second to 1/10000 second.  

 

There is an automatic setting (Electric Iris), in which the shutter speed is adjusted automatically according 

to the overall light level. 

 

There is also “flickerless” shutter speed, which is used to prevent fluctuations in image brightness when 

operating under fluorescent lighting. 

8.1.3. Back Light Compensation (BLC Control) 

Under normal lighting conditions, with the Electronic Iris control activated, the camera will automatically 

adjust the image brightness so that all parts of the image are visible.  

 

However when the background illumination is very bright – for example, when someone is standing in 

front of a window – the shutter speed will automatically reduce which will cause the foreground image to 

appear darkened. Faces may appear as if in silhouette making it difficult to see any detail.  

 

In this situation, Back Light Compensation (BLC) can be used to increase the brightness of certain parts of 

the image.  

 

Shutter Mode 

BLC Control 

WB Mode 

Mirror Mode 

Edge Enhancement 

Manual Gain 

Interleave 
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Back Light Compensation effectively limits the area of the screen in which the AGC operates, thus 

ensuring that details within the area will not be lost. As a consequence, regions of the image outside of 

the BLC area may become very bright and washed out. 

 

To enable BLC simply click on the BLC Check box. 

 

To display and/or change the BLC area, click on the On Screen Display box. 

 

An 8 x 8 grid will appear over the image with 

a red box drawn around the active BLC 

window. To move the BLC window, you can 

either drag it with the mouse, or enter the X 

and Y co-ordinates in the control panel. 

 

The size of the BLC window can vary in both 

size and shape. The BLC window controls the 

size and the BLC window posn controls 

where the BLC area is within the grid. 

 

The level of BLC can be adjusted using the 

WEIGHT function on the BLC control panel. 

 

 

 

 

 

 

 

 

NOTE:  Videology supplies the camera's 

default option in BLC with a center weighting. 

   BLC will only function when the shutter speed is set to “Electric Iris.” 

 

The effect of Back Light Compensation is shown in the following images. 
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Back Light Compensation OFF (top image) and Back Light Compensation ON (Bottom Image). 
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8.1.4. Mirror Mode 

The mirror mode option is simply used to provide a mirror inversion of the image. This feature is used 

when the camera is viewing the subject through a mirror. 

 

 

8.1.5. Reset 

The Reset feature is used to restore all the settings to the factory default values. 
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8.1.6. Edge Enhancement 

Edge enhancement is used to make the edges of lines appear sharper and more distinct. It gives the 

appearance of increased resolution, but in reality the resolution is determined purely by the number of 

pixels, and is fixed. 

 

The effect of edge enhancement is illustrated below. 

 

  
 

Edge Enhancement OFF (top image) and ON (bottom image) 
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8.1.7. Manual Gain 

Manual Gain provides a means of controlling the overall image brightness. 

 

Gain can be set to automatic (unchecked), in which case the camera will automatically adjust to variation 

in illumination and subject matter or manual (checked) in which the user controls the variation in 

illumination and subject matter. 

 

  
 

Gain Control low (top image) Gain Control high (bottom image) 
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8.1.8. White Balance (WB) Mode 

Under varying lighting conditions, (sunlight, fluorescent lighting etc) the perceived color of objects will 

change. This is true for the human eye and also for the video camera. 

 

The color spectrum of a light source varies according to its’ 

temperature. A tungsten lamp for example operates at a 

relatively low temperature of about 2800K (~3000˚C) 

whereas the sun has an equivalent color temperature of 

about 5500K (~5800˚C). 

 

We typically classify light sources by their “color 

temperature” which is a measure of the temperature of a 

perfect black body that would radiate light with the same 

spectral (color) content. 

 

As the color temperature of a light source increases, the 

spectrum of the emitted light moves from red to blue. Thus 

a piece of white paper viewed under a tungsten lamp would 

have a slightly reddish hue, whereas when viewed under 

sunlight it would appear to be slightly blue by comparison. 

 

Fluorescent lamps operate very differently from 

incandescent lamps, and can have color temperatures 

ranging from 3000K to 5000K. 

 

The White Balance control function is used to change the 

color settings within the camera so that white appears white. 

 

There is an Automatic White Balance mode, in which the 

camera automatically adjusts according to the scene 

content. 

 

In addition to the automatic white balance, there are three 

fixed white balance settings, WB mode1, WB mode2 and WB 

mode3. 

 

Mode 1 is user configurable, using the Rgain and Bgain controls within the control panel, and can be 

used to give the desired color reproduction under specific lighting conditions. 

 

Modes 2 and 3 are preset for indoor (fluorescent lighting) and Outdoor (sunlight) use. 
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8.1.9. Advanced Options 

Advanced Settings can be selected by Options > Advanced Options… 

 

 
 

When Advanced Options is selected, the Advanced Options window is opened. 

 

 
Figure 1. Advanced Properties Menu 

8.1.9.1. Isochronous and Bulk transfer modes. 

There are two basic transmission modes for data on the USB bus. These are referred to as Isochronous 

and Bulk Transfer. 

 

Under the Isochronous Transfer mode a fixed bandwidth (up to a maximum of 40% of the total 

available) is assigned to the camera, ensuring a minimum speed of transmission. In this transfer mode, 

there is no error correction and any dropped data will not be re-transmitted. This mode is typically used 

for time sensitive data such as video and speech where there is little utility in repeating lost information. 

 

Under the Bulk Transfer mode there is no fixed (upper or lower) limit to the available bandwidth, and 

data is simply transmitted whenever the bus is available. Bulk transfer includes error correction and 

dropped data packets, which are retransmitted. 
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If multiple USB cameras are operated simultaneously, it is possible that the data rate from the camera will 

be reduced; resulting in a slower frame rate for the displayed image, and under this situation the 

isochronous display should be used. 

 

If only one camera is being used, then the bulk transfer mode will probably provide the fastest display. 

 

NOTE: 

When changing the transfer mode from Isochronous to Bulk, it is necessary to close the application, 

unplug and reconnect the camera, and restart the application. 

8.1.10. Still Image Capture (Snap Feature) 

 
 

The Image Snap feature is located under the File menu and is used to acquire and store still images from 

the video display.  The “Set Snap Image Folder…” button is used to change the location where snapshot 

images will be saved. The files are saved to the user’s desktop by default. The files are stored as Bitmap 

(BMP) files. 
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8.2. Using the Videology viewer with model 24B1.3XUSB-C  

Please refer to section 6 Viewer and USB Driver Installation for viewer installation instructions. 

 

To launch the viewer software, simply click on the Videology Icon on the Desktop. A window will appear 

displaying the camera image. 

 

 
 

8.2.1. Camera Settings 

The Camera Settings (gain, shutter speed etc.) can be selected via Options > Camera Settings… 

 

 

8.2.1.1. Video Capture Filter Properties 

When Camera Settings is selected, the Video Capture Filter Properties window is opened. 

 



Doc # INS-07019 Issue Date: 06/03/2016 

Revision: F Page 27 of 53 

 

 
 

Figure 2. Video Capture Filter Properties 

 

8.2.1.2. Gain Control 

The gain control is used to vary the image contrast. To alter the gain, simply move the slider control and 

click on the Apply button on the bottom right corner of the box. 

8.2.1.3. Shutter Speed and Frame Rate 

The camera’s shutter speed is analogous to the shutter speed of a conventional camera, although for a 

solid state imager there is no physical shutter. For this type of camera, shutter speed refers to an 

electronic shutter, which determines the length of time over which charge is accumulated on the image 

sensor. 

 

In low light conditions, a slow shutter speed (long integration time) is required in order to get a good 

quality image.  

 

Shutter speed for the 24B1.3XUSB-C camera can be varied from 0.6 second to 1/5000 second. The 

camera utilizes a rolling shutter, which operates in a fashion similar to a focal plane shutter on a 

conventional camera. 

 

With this type of shutter, different parts of the sensor are exposed at different times, which can result in 

distortion of moving objects. 

 

Note: Faster shutter speeds should not be used when operating the camera under fluorescent lighting. The 

intensity of the light varies at the AC line frequency (60Hz) and causes dark bands to appear across the 

image.  

 

On all solid state cameras, the period of time over which the pixels are actively collecting light and 

converting it to charge is referred to as the integration time. (This is analogous to the shutter speed of a 

conventional camera). 

 

For most CCD cameras, all pixels are exposed for the duration of the integration time (this is like a simple 

full frame shutter that opens and closes to expose the entire sensor). 

Most CMOS sensors however employ what is known as a rolling shutter, in which only a band of pixels are 

exposed at any instant of time. This is just like the focal plane shutter of more expensive conventional 

cameras. 

 

Gain Control 

Shutter Speed 

Mirror Mode 

and Flip Mode 

Gain Control Version of 
Software 
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In this case the integration time is determined by the width of the moving band, which starts from the top 

of the sensor and works its way down. 

 
 

Now it is possible for the integration time to exceed the frame period. When this happens the vertical 

blanking period is extended to accommodate the extra time. The frame rate will be slower, but the frame 

period will remain the same. 

 

This is illustrated on the following page. 

 

Basically the Rolling shutter begins “moving” on the trailing edge of the V sync Pulse. 

 

Integration time 

is set by width of 
this rolling band 

Rolling Shutter 

Moves down the 
sensor 
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In the example shown the frame period if 50 ms, and the integration time is 100 ms. You can see that this 

has the effect of increasing the vertical blanking by 50 ms and so it slows the frame rate down. 

 

So for your application where you want to limit the LED “On time to 25 ms. I would recommend that you 

do the following. 

 

The frame rate of the camera is about 20 fps at full resolution. 

This corresponds to 50 ms frame time. 

Set the shutter speed to 2/15 sec (~130 ms). 

Trigger the camera and wait for about 50 ms. Then turn on the LEDs for 25 msec 

This will ensure that all pixels are active while the LED is on. 

 

After the 130 ms you will get a single frame of video. 

 

8.2.1.4. Mirror and Flip Mode 

The Mirror and Flip options are used to create images which are mirrored about the Vertical and Horizontal 

axis respectively. 

 

 

 

Start, t - 0 Shutter 

Starts to move 
down the sensor 

T = 30 ms 

bottom of shutter 

is at bottom of 
sensor 

Shutter 

Width = 
100 ms 

Frame 

width= 
50 ms 

T = 60 ms Top of 

shutter is at 

bottom of sensor 

Vertical  

Blanking 
Period 
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8.2.2. Capture Format 

Capture Format can be selected by Options > Capture Format… 

 

 

8.2.2.1. Video Capture Pin Properties 

When Capture Format is selected, the Video Capture Pin Properties window is opened. 

 

 
 

Figure 3. Video Capture Pin Properties 

 

Frame Rate 

The Frame rate will vary depending upon the screen resolution. 

 

Color Space/Compression 

The Color Space/Compression is fixed to UYVY and cannot be varied. 
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Output Size 

 

 

 

 

 

 

 

 

 

Table 1 Maximum Frame Rate for various screen resolutions. 

 

 
 

 

 

 

 

Resolution (pixels)  Maximum Frame rate 
1280 x 1024 8 fps 
1024 x 768 12 fps 
800 x 600 20 fps 
640 x 480 30 fps 

320 x 240 (default) 60 fps 

320 x 240 

640 x 400 

800 x 600 

1024 x 768 

1280 x 1024 
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8.2.3. Advanced Options 

Advanced Settings can be selected by Options > Advanced Options… 

 

When Advanced Options is selected, the Advanced 

Options window is opened. 

 

 
 

Figure 4. Advanced Properties Menu 

 

 

 

8.2.3.1. Isochronous and Bulk transfer modes. 

There are two basic transmission modes for data on the USB bus.  These are referred to as Isochronous 

and Bulk Transfer. 

 

Under the Isochronous Transfer mode a fixed bandwidth (up to a maximum of 40% of the total 

available) is assigned to the camera, ensuring a minimum speed of transmission. In this transfer mode, 

there is no error correction and any dropped data will not be re-transmitted. This mode is typically used 

for time sensitive data such as video and speech where there is little utility in repeating lost information. 

 

Under the Bulk Transfer mode there is no fixed (upper or lower) limit to the available bandwidth, and 

data is simply transmitted whenever the bus is available. Bulk transfer includes error correction and 

dropped data packets, which are retransmitted. 

 

If multiple USB cameras are operated simultaneously, it is possible that the data rate from the camera will 

be reduced; resulting in a slower frame rate for the displayed image, and under this situation the 

isochronous display should be used. 

 

If only one camera is being used, then the bulk transfer mode will probably provide the fastest display. 

 

NOTE: When changing the transfer mode from Isochronous to Bulk, it is necessary to close the 

application, unplug and reconnect the camera, and restart the application. 
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8.2.3.2. Still Image Capture (Snap Feature)/ V Sync. (24B1.3XUSB-V) 

The camera features two still image “Snapshot modes”. In the first mode, the camera will deliver a single 

frame image in response to a trigger command. This option is ideal for capturing single, randomly timed 

events, such as moving bar codes. 

 

In the second mode, using our 24B1.3XUSB-V, a single frame of video can be captured from the 

streaming video in response to a trigger signal. Using the Vertical Sync output signal, the trigger pulse can 

be synchronized with the start of each video frame. This feature is ideal for synchronizing the snapshot 

with a strobe light. 

 

 

8.2.3.3. Acquiring a still image in Frame Grabber mode 

In frame grabber mode, the still image can be captured by using the Take Snapshot option under the 

File Menu. 

 

The “Set Snap Image Folder…” button is used to change the location where snapshot images will be 

saved. The files are saved to the user’s desktop by default. The files are stored as Bitmap (BMP) files. 

 

Filename = Still_DATE_TIME_NUMBER.bmp. 

 

Alternatively, the image can be captured by putting a high level (3.3V) on pin 2 of connector J300 on the 

camera circuit board. This input is triggered by a Low to High transition of the pin, and holding the pin 

high will not result in multiple images. 

 

Normally there will be some uncertainty as to which frame is acquired when the hardware trigger is used. 

If for example the trigger pulse is issued late within the vertical frame period of the camera, then there 

may be a latency of one frame before the still image is captured. 

 

To overcome this uncertainty, it is possible to synchronize the hardware trigger with the Vertical sync 

signal of the camera. This feature is available on the 24B1.3XUSB-V camera only. 

 

On this camera, a Vertical sync pulse is provided on pin 3 of J101 as shown. 
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Connector Pin Outs for 24B1.3USB_V 

8.2.3.4. Sample Circuit for Snapshot Synchronization. 

Below is a simple circuit that can be used to synchronize the Hardware snapshot trigger with the vertical 

sync, so as to capture a sequence of 8 LEDs each of which is turned on for one full frame period. U1 is a D 

Type Flip Flop, U2 is a Decade counter with Decimal outputs. 

 

Note that the hardware trigger needs to go low at the beginning of the frame in order to ensure that the 

frame is captured. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Circuit for Synchronizing Hardware Trigger with Vsync and LED Sequence. 

J100 

J101 

J300 

 

1 

1 

1 

+5 V 

D- 

D+ 

GND 
GND 

GND 

+3.3V 

VSync  

GND 

Trigger 

GND 

Start 

CLK 

D Q 

Q 
CLK EN 

CLK 

To Camera  
Hardware trigger 

V Sync 

CLR 

Q0 

Q1 

Q2 

Q3 

Q4 

Q5 

Q6 

Q7 

U1 
U2 4017 

Q8 
RST 
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8.2.4. Control 

Control Option is inactive for the 1.3 Megapixel Cameras 

8.2.5. Help (About Menu) 

The Help feature states the properties of the software. 
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8.3. Using the Videology viewer with models 24C1.3XUSB and 24C7.38USB-F 

Please refer to section 6 Viewer and USB Driver Installation for viewer installation instructions. 

 

To launch the viewer software, simply click on the Videology Icon on the Desktop. A window will appear 

displaying the camera image. 

 

8.3.1. Still Image Capture (Snap Feature) 

 

 
 

The Image Snap feature is used to acquire and store still images from the video display and is initiated by 

selecting the Take Snapshot Option under the File menu.  

 

The “Set Snap Folder…” button is used to change the location where snapshot images will be saved. The 

files are saved to the user’s desktop by default and are stored as Bitmap (BMP) files. 

 

Filename = Still_DATE_TIME_NUMBER.bmp. 

 

 

If using 24C7.38USB-F, please see section 8.3.9 for flash option instructions 

 

 

Enable HW Snapshots 

Needs description. 

 

Take Snapshot 

Takes a snapshot. 

 

Exit 

Exits the program 
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8.3.2. Camera Settings 

The Camera Settings (gain, shutter speed etc.) can be selected via Options > Camera Settings… 

 

 

8.3.2.1. Video Capture Filter Properties 

When Camera Settings is selected, the Video Capture Filter Properties window is opened. There are two 

tabs within the Video Capture Filter Properties; 24C13 Properties and 24C13 Zoom/Pan Properties. 

 

 

8.3.2.2. 24C13 Properties 

 

 

Parameters 

White Balance 

Edge 

Enhancement 

Version of 

Software 

Backlight 

Compensation 
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8.3.2.3. Parameters 

8.3.2.3.1. Shutter Speed  

The camera’s shutter speed is analogous to the shutter speed of a conventional camera, although for a 

solid state imager there is no physical shutter. For this type of camera “shutter speed” refers to an 

electronic shutter, which determines the length of time over which charge is accumulated on the image 

sensor. 

 

In low light conditions, a slow shutter speed (long integration time) is required in order to get a good 

quality image.  

 

This camera’s shutter speed can be varied from 1/15 sec. to 1/120 sec. The camera utilizes a rolling 

shutter, which operates in a fashion similar to a focal plane shutter on a conventional camera. 

 

With this type of shutter, different parts of the sensor are exposed at different times, which can result in 

distortion of moving objects. 

 

There is also an automatic setting (AUTO), in which the shutter speed is adjusted automatically according 

to the overall light level. 

 

Note: Faster shutter speeds should not be used when operating the camera under fluorescent lighting. The 

intensity of the light varies at the AC line frequency (60Hz) and causes dark bands to appear across the 

image. 

8.3.2.4. Gain Control 

Gain can be set to automatic (unchecked), in which case the camera will automatically adjust to variation 

in illumination and subject matter or to manual (checked) in which the user controls the variation in 

illumination and subject matter. 

8.3.2.5. Gamma Correction 

 Gamma correction switches between 0.45 and 1.0 to accommodate various monitors. 

8.3.2.6. Mirror and Flip Mode 

The Mirror and Flip options are used to create images, which are mirrored about the Vertical and 

Horizontal axis respectively. 

8.3.2.7. Mains Freq 

This is set to 50 Hz or 60 Hz to keep the shutter in sync with the line frequency. 

8.3.2.8. Saturation Slider 

 

This slider controls the scene’s depth of color. 

8.3.2.9. White Balance 

 

Auto – Adjusts the colors based on the scene and corresponding internal measurements; 

Fixed balance Red & blue – Allows the user to adjust the amount of red and blue in the scene. 

8.3.2.10. Mode 

Drop down 

 Manual 

 Auto (simple) 

 Auto (fancy) 

 PWB (push to set) 
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8.3.2.11. Manual White Balance 

When Manual mode is selected, Red and Blue levels can be adjusted from 0 to 255. 

8.3.2.12. Edge Enhancement 

Edge enhancement is used to make the edges of lines appear sharper and more distinct. It gives the 

appearance of increased resolution, but in reality the resolution is determined purely by the number of 

pixels, and is fixed. 

8.3.2.13. Back Light Compensation (BLC Control) 

Under normal lighting conditions, with the Electronic Iris control activated, the camera will automatically 

adjust the image brightness so that all parts of the image are visible.  

 

However when the background illumination is very bright, as when someone is standing in front of a 

window for example, the shutter speed will automatically be reduced causing the foreground image to 

appear darkened. With the image appearing in this way, faces may look almost in silhouette making it 

difficult to see any detail.  

 

In this situation, Back Light Compensation (BLC) can be used to increase the brightness of certain parts of 

the image.  

 

Back Light Compensation effectively limits the area of the screen in which the AGC operates, thus 

ensuring that details within the area will not be lost. As a consequence, regions of the image outside of 

the BLC area may become very bright and washed out. 

 

To enable BLC simply click on the Enable Backlight Compensation Check box.  

 

The size of the BLC window can vary in both size and shape. To change the BLC size, click on the Region 

Width and/or the Region Height radial buttons and choose 1/8, ¼, ½, or Full.   

 

To change the X or Y position, click on the arrows provided above and/or to the left of the 8 x 8 grid. 
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8.3.3. Capture Format 

Capture Format can be selected by Options > Capture Format… 

 

 

8.3.3.1. Video Capture Pin Properties 

When Camera Format is selected, the Video Capture Pin Properties window is opened. 

 

 
 

Figure 5. Video Capture Pin Properties 

 

Frame Rate 

The Frame rate will vary depending upon the screen resolution. 

 

Color Space/Compression 

The Color Space/Compression is fixed to UYVY and cannot be varied. 
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Output Size 

 

 

 

 

 

 

 

 

 

Table 2 Maximum Frame Rate for various screen resolutions. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Resolution (pixels)  Maximum Frame rate 
1280 x 1024 8 fps 
1024 x 768 12 fps 
800 x 600 20 fps 
640 x 480 30 fps 

320 x 240 (default) 60 fps 

320 x 240 

640 x 400 

800 x 600 

1024 x 768 

1280 x 1024 
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8.3.4. 24C13 Zoom/Pan Properties 

 

 
 

The red square is the area of interest.  

 

The zoom feature enables the user to change where the viewing area is located. This area is dependent on 

what output size is selected within the Video Capture Pin Properties (section 8.3.2.1). 

 

Zoom/Pan Box 
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8.3.5. Advanced Options 

Advanced Settings can be selected by Options > Advanced Options… 

 

 
 

The Advanced Options window is opened. 

 

 
Figure 6. Advanced Options Menu 

8.3.5.1. Isochronous and Bulk transfer modes. 

There are two basic transmission modes for data on the USB bus, referred to as Isochronous and Bulk 

Transfer. 

 

With Isochronous Transfer mode a fixed bandwidth (up to a maximum of 40% of the total available) is 

assigned to the camera, ensuring a minimum transmission speed. In this transfer mode, there is no error 

correction and any dropped data will not be re-transmitted. This mode is typically used for time sensitive 

data such as video and speech where there is little utility in repeating lost information. 

 

With Bulk Transfer mode there is no fixed (upper or lower) limit to the available bandwidth, and data is 

simply transmitted whenever the bus is available. Bulk transfer includes error correction and dropped data 

packets, which are retransmitted. 

 

If multiple USB cameras are being operated simultaneously, it is possible that the data rate from the 

camera will be reduced, resulting in a slower frame rate for the displayed image.  In this situation the 

isochronous display should be used. 

 

If a single camera is being used, then the bulk transfer mode will likely provide the fastest display. 
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NOTE: 

When changing the transfer mode from Isochronous to Bulk, it is necessary to close the 

application, unplug and reconnect the camera, and restart the application. 

 

8.3.6. Factory Reset 

Factory Reset will bring up a dialog box.  If “OK” is selected the camera will be reset the next time it is 

plugged into the PC.  

 

 
 

 
 

8.3.7. Control 

Control setting is inactive with 1.3 Megapixel Cameras 

 

8.3.8. Help (About Menu) 

The Help feature states the properties of the software. 
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8.3.9. Taking Flash Pictures 

For flash photography, you should set the camera up so that the distance to the subject is approximately 

6 ft. If the camera is too close to the subject the image will be overexposed. 

 

Once the camera is set up, adjust the manual focus control on the lens to bring the subject into sharp 

focus. 

 

When you first connect the camera and flash module to the PC it will take approximately 15 seconds for 

the flash unit to charge. Full charge is indicated when the small amber light on the rear of the flash 

module is on. Re-charging between flash pictures takes only a second or two. 

 

 

 

 
 

To take flash pictures, click on the “Take Snapshot” option from the file menu. You will see the flash light 

come on and a still image frame will be captured and stored in the assigned snapshot folder. 

 

Please refer to section 8.3.7 for still image capture instructions. 

 

 

8.3.9.1. Adjusting the Flash intensity 

If the flash intensity is too high, it can be reduced simply by turning the control knob on the side of the 

flash module.  

 

Moving the control towards the front of the unit will increase the flash intensity, moving it towards the 

back will decrease the intensity. 

 

 

Full Charge 
Indicator 

USB Port 

Flash Intensity 
Control 

INCREASE DECREASE 
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8.4. Using the Videology viewer with models 20/21C11XUSB and 20/21C21XWUSB 

Please refer to section 6 Viewer and USB Driver Installation for viewer installation instructions. 

 

To launch the viewer software, simply click on the Videology Icon on the Desktop. A window will appear 

displaying the camera image. 

 

 

8.4.1. Still Image Capture (Snap Feature) 

 

 
 

The Image Snap feature is used to acquire and store still images from the video display and is initiated by 

selecting the Take Snapshot Option under the File menu, after enabling the snapshots through Enable 

HW Snapshots.  

 

The “Set Snap Image Folder…” button is used to change the location where snapshot images will be 

saved. The files are saved to the user’s desktop by default and are stored as Bitmap (BMP) files. 

 

Filename = Still_DATE_TIME_NUMBER.bmp 
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8.4.2. Camera Settings 

The Camera Settings (gain, shutter speed etc.) can be selected via Options > Camera Settings… 

 

 
 

This selection will activate the OSD controller for this family of cameras. 

 

 
  

Using the mouse select the Start/Stop button. 

 

The OSD menu will appear on the screen.  

 

Please refer to and INS-2XC21XW-USB instructions on how to navigate the OSD menu. 



Doc # INS-07019 Issue Date: 06/03/2016 

Revision: F Page 48 of 53 

 

8.4.3. Capture Format 

Capture Format can be selected by Options > Capture Format… 

 

 
 

 
 

Frame Rate is locked in at 30 FPS. 

 

Output Size is camera dependent and is locked in as follows: 

 

20C20XW-USB 640 x 480 

21C20XW-USB 640 x 576 

20C20XW-USB 640 x 480 

21C20XW-USB 640 x 576 
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8.4.4. Advanced Options 

Advanced Settings can be selected by Options > Advanced Options… 

 

 
 

The Advanced Options window is opened. 

 

 
Figure 7. Advanced Options Menu 

8.4.4.1. Isochronous and Bulk transfer modes. 

There are two basic transmission modes for data on the USB bus, referred to as Isochronous and Bulk 

Transfer. 

 

With Isochronous Transfer mode a fixed bandwidth (up to a maximum of 40% of the total available) is 

assigned to the camera, ensuring a minimum transmission speed. In this transfer mode, there is no error 

correction and any dropped data will not be re-transmitted. This mode is typically used for time sensitive 

data such as video and speech where there is little utility in repeating lost information. 

 

With Bulk Transfer mode there is no fixed (upper or lower) limit to the available bandwidth, and data is 

simply transmitted whenever the bus is available. Bulk transfer includes error correction and dropped data 

packets, which are retransmitted. 

 

If multiple USB cameras are being operated simultaneously, it is possible that the data rate from the 

camera will be reduced, resulting in a slower frame rate for the displayed image.  In this situation the 

isochronous display should be used. 

 

If a single camera is being used, then the bulk transfer mode will likely provide the fastest display. 
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NOTE: 

When changing the transfer mode from Isochronous to Bulk, it is necessary to close the 

application, unplug and reconnect the camera, and restart the application. 

 

8.4.5. Control 

Control setting is inactive with the 2xC21XW-USB cameras. 

 

8.4.6. Help (About Menu) 

The Help feature states the properties of the software. 
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9. Using the TWAIN Interface - ALL MODELS 

Please refer to section 7 for TWAIN installation instructions. 

 

If the Twain interface (SFT-10011) is installed the camera can be used with any TWAIN Compliant 

Application.  

 

The TWAIN interface will attach itself to the first Videology camera it finds connected to the computer. For 

best operation, run the TWAIN Interface on a system that has only one Videology camera installed. 
 

Any application that supports a TWAIN Data Source as a capture device can access the camera. The 

camera's image will appear as shown below: 

 

 
 

 

10. Troubleshooting 

10.1. Focus Issues 

If the video appears out of focus, check that the lens is focused properly. Typically, a lens is pre-installed 

and is pre-focused for an optimal head shot distance of 3.5 to 7 feet from the camera. If your subject is 

out of that range then you will need to make a slight adjustment to the lens. 

 

Unlock the locking screw on the lens and rotate the lens very slightly watching to see if the subject comes 

in to focus. When you have the proper focus for the distance, lock the locking screw securely. It is possible 

for a very tight locking twist to cause a slight focus shift, so take care to lock the screw gently and to 

recheck that the image is still property focused. 

10.2. Noisy or Grainy Video 

Be certain that there is enough light in the room where the images are snapped and that your subject is 

not located directly under a bright spotlight.  

10.3. Poor Color Reproduction 

Try the various white balance choices in the event that you have strange lighting conditions. The camera’s 

default setting is set for standard fluorescent lighting. If the camera is setup outdoors, you may require a 

more optimal white balance. 
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10.4. Dark faces 

Subjects should not be placed in front of overly bright backgrounds, such as a window with sunlight 

streaming through it.  At the same time, be certain that the environment provides enough overall light.  

Additionally, a solid light grey backdrop is preferred for headshots.   

10.5. Reflections 

Take care that the camera lens is at approximately the same height as the subject’s nose. There should 

not be a high light point source in the ceiling angled in to the subjects face. This may cause glasses to 

reflect or shadows to appear on the face.  A hot white dispersed light aimed directly on to the face is 

sometimes needed for an ideal image capture. 

10.6. Video display shows a green or black color 

For Win XP and Win 2000, update USB 2.0 Host driver to the latest driver from the Microsoft® web site. 

For Win 98 SE and Win Me, an OS upgrade to either Win XP or Win 2000 with latest Microsoft® USB 2.0 

Host driver is necessary. 

10.7. Video display appears inoperable or exhibits a slow frame rate 

Verify the system complies with the minimum system requirement specification. 

Try a different USB 2.0 port in your system. 

Try to lower the video quality, by going to Options > Capture Pin > quality > change the value to 0. 

Try a different video format, YUY2 or I420. 

Verify VGA card supports Direct Show, and upgrade VGA card to the latest driver. 

10.8. An incomplete or scrambled video display on USB 1.1 port 

Verify the system complies with the minimum system requirements.  

Unplug all of USB1.1 devices from the system.  

Verify that the USB1.1 video camera device is the only USB device in the system. 

10.9. Cannot see video 

Unplug and plug the camera in again. 

Reinstall the USB Video driver. Follow the procedures below on how to reinstall the camera under different 

scenarios. 

 

Scenario 1: Hardware-First, Driver Installed before, but not correctly 

Windows XP 

Make sure that the camera is plugged into one of the USB ports. 

Insert the Videology CD that was provided with the camera into a CD-ROM drive. The “Videology USB2.0 

Camera Installation Wizard” software will run automatically.  

If the autorun.exe software does not run automatically, browse the CD files and double click on the 

“autorun.exe” file to run it. 

 

(Note: The auto-run application runs or not when media CD inserted depend on the "auto insert 

notification" option checked in the properties of your CD drive. The method of changing this setting 

depends on what exact version of Windows you have. For information on how to do this, do a search in 

Windows Help for "auto insert notification.") 

Click on the “Next” button. 

 

If problems still persist, please email support@videologyinc.com 

 

Please include: 

 Date of purchase 

 Software revision number 

 Camera model number 

 Company name 

 Contact name 

 Phone number 

 Email address 

 Issue with camera 

mailto:support@videologyinc.com
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11.  Contact Information 

For technical assistance with this product, please contact the supplier from whom the product 

was purchased. 

 

 

 

For OEM inquiries, contact Videology Imaging Solutions: 

 
 

 
 
 

Please visit our website at:  http://www.videologyinc.com 

 

 

 

 

VIDEOLOGY IMAGING SOLUTIONS is an ISO 9001 registered video camera developer and 

manufacturer serving industrial, machine vision, biometric, security, and specialty OEM markets. 

Videology designs, develops, manufactures, and distributes video, image acquisition, and display 

technologies and products to OEMs worldwide. 

Americas, Middle East, Far East & Australia: Europe & N. Eurasia: 

Videology® Imaging Solutions Inc. 

37M Lark Industrial Parkway 

Greenville, RI 02828 

USA 

 

Tel: (401) 949-5332 

Fax: (401) 949-5276 

Videology® Imaging Solutions Europe B.V. 

Neutronenlaan 4 

5405 NH Uden 

The Netherlands 

 

Tel: +31 (0) 413-256261 

Fax: +31 (0) 413-251712 

http://www.videologyinc.com/

